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Dear Clients and Friends 

 

August already! And still plenty of time to watch baseball and eat hotdogs before the kids go back to school. It seems the 

world has breathed a collective sigh of relief as many of the covid-related restrictions have been lifted. People are going 

to the movies again; bands are filling big venues with great music, and we can actually see our friends’ faces for the first 

time in two years – hmmm - might have to rethink that last one! Hey, if you have a student going back to school in a few 

weeks, this newsletter contains an article with some laptop recommendations, so let’s get to it. 

 

For this issue we reached into the mail bag (email, that is) and found some of our client’s requests for help, and the 

solutions we came up with. We thought you might like to see the answers to some common problems. Elsewhere, we’ll 

take a look at Microsoft Word’s helpful (and very cool) transcribing feature, and then we’ll delve into the difference 

between laptop and desktop computers and give you some sage advice about how to choose one over the other. So that 

said, let’s get started! 

 

Referrals 
TekResults owes much of its success to our loyal and enthusiastic clients. It’s those of you who tell your friends about us 

that keep our company growing, and we’d like to say thanks. Just telling someone about us is all it takes. Just let us know 

you dropped our name and we’ll drop a gift card in the mail. See, who said talk is cheap! 

 

Businesses Who Need Our Referrals 
Any business who has slow computer systems  

Any business who has slow network 

Any business needing a better disaster recovery strategy including backups for mission-critical devices (servers, essential 

PCs, etc.), equipment redundancy,  

Any business requiring help upgrading existing IT infrastructure due to obsolescence 

Any business that needs better email services 

Any business that needs to migrate to a new software platform 

Any business that needs help with its industry vertical market software 

Any business that has employees and compliance questions 

Any business that needs help with employees working from home 

Any business that needs reliable IT service 

Any business that is purchasing another business and needs IT help 

Any business that is being sold or is being dissolved 

Any business with human resource issues as they pertain to IT 
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Any business that wants to save money and improve functionality by utilizing a  VoIP Business phone systems 

Any business needing a better security infrastructure 

Any business needing remote desktop applications 

Any business needing help migrating to Microsoft 365 

Any business that would benefit from monitoring of performance, security, etc. of their IT infrastructure 

Any business that would like an IT department that will visit and report on each device on a scheduled basis 

Any business that would like to read our newsletter or other mail tips and blasts 

 

How to fix some common problems 
We get emails and calls from clients every day asking us to help resolve issues. Years ago, the requests were for simple 

problems, mostly caused by user error, but with today’s “more sophisticated” users, many of the issues we troubleshoot 

are indeed puzzling. We thought it might be interesting, and hopefully helpful, to reveal some of the issues we have 

solved recently and to give you the fixes we came up with. The problems and fixes we present here are taken directly 

from our mail bag and are actual instructions we sent to clients after fixing their issues. 

 

OneDrive is not syncing 
The instructions in this section assume you are using OneDrive for work or school and not a personal OneDrive account. 

One way to tell the difference is OneDrive icons for work or school are blue. Personal OneDrive icons are white. 

 

 
 

If you make changes to a document stored in OneDrive on your desktop and then open that same document later from 

your laptop and the earlier changes are not present, OneDrive is failing to sync your devices.  

How to fix 
First, make sure you are signed into OneDrive on both devices. If for some reason you are signed out of OneDrive, 

OneDrive will not sync. If you are signed out of OneDrive, the OneDrive cloud icon in your system tray (the area next to 

the clock in the taskbar) will most likely have a line through it. If that’s the case, you can simply click on the cloud icon 

and sign in with your email address and password when prompted. 

If you are still having sync problems, you may need to reinitiate the sync from within the cloud. Sign in at Office.com 

with your work account and go to the OneDrive app. Navigate to your parent OneDrive folder and click the Sync button 

in the menu. OneDrive will take you through the process of resyncing your documents. 

 

When saving a Word or Excel document, OneDrive issues warning: Upload Blocked, We couldn't verify 

you have the necessary permissions 

How to fix 
1. Right click on the blue OneDrive cloud in your system tray (next to the clock). 
2. Click the Help & Settings cog in the top right and choose Settings. 
 



 
 

3. Click the Office tab and then uncheck the box that says Use Office applications… 
4. Click OK. 
 

 
 

 

Outlook meetings are all Teams meetings 
When you create a meeting invitation in Outlook, Outlook creates a Microsoft Teams meeting invitation. 

How to fix 
1. In Outlook, go to File > > Options. 

2. Click Calendar in the left panel. 



3. In the Calendar options section of the right panel, uncheck Add online meeting to all meetings. 

 

Office apps are slow to open 
Many times, the problems with Office apps can be traced to add-ins that are interfering with an app’s normal operation. 

Add-ins are usually third-party tools that are designed to provide extended features for an Office app. The add-ins are 

installed when the third-party app is installed. 

How to fix 
Open the Office app in safe mode. Doing this disables all add-ins automatically. To open an Office app in safe mode, just 

hold down your keyboard’s CTRL key while clicking on the icon to open the Office app. Click Yes. 

 

If working in safe mode solves the problem, the cause of the problem is almost certainly a misbehaving add-in. Exit the 

Office app and reopen it normally. Next, disable all add-ins and then reenable them one at a time until you discover 

which one is causing the problem.  

1. Click File > Options > Add-ins 

2. Click Go next to Manage COM Add-ins. Note, there are several types of add-ins available from this pull-down menu. 

Excel has its own additional add-ins. These can be disabled as well. 

3. Uncheck the add-ins you wish to disable and click OK. 

 

Missing or deleted files 
If you accidentally delete or misplace a file that is stored on a server, you may be able to recover it from Windows’ 

previous versions feature. 

1. In File Explorer, right click on the parent folder of the missing file and choose Properties. 

2. Click the Previous Versions tab of the Properties dialog.  

3. If there are previous versions of the folder available, they will be listed alongside the date they were created.  In 

most cases you will not want to just restore the folder to its original location and overwrite the existing folder. 

Better to restore to a safe location and then assess the missing file from there; decide what to do with it then. To 

restore to another location, click the down arrow next to the Restore button and choose Restore To. 

 

 
Previous versions can also be set up on a Windows 10/11 workstation, but it requires you to turn on Windows File 

History and then designate a backup drive to contain the backups of the files. It isn’t necessary to do this on a server if 

the server’s shadow copy feature is enabled.  

 

Hard drive is running out of space 
A full hard drive will seriously slow your computer down, but it’s often difficult to determine what’s using all the space. 

In File Explorer, click This PC (left panel). The right panel should then tell you the size of each drive as well as the amount 

of its free space. Although that tells you size and usage, it doesn’t tell you what is using the space. For that you will need 

a tool. 

 

https://www.online-tech-tips.com/windows-10/how-to-restore-previous-versions-of-files-in-windows-10/


 
 

One such tool is SpaceSniffer by Underzo Software. It is freeware and can be downloaded from their website. 

SpaceSniffer will scan your drive and present your file structure in an easy-to-understand box-in-a-box window, with 

each box representing a folder, and listing the file size of the folder’s contents. The SpaceSniffer website even has videos 

to demonstrate how to use the tool.  

 

After determining what is eating your disk space, you may decide to delete some files or move them to external storage. 

Alternately, a larger hard drive could be installed to replace the current drive, although you should have this done 

professionally. 

 

Outlook is taking up disk space 
You may not realize it, but if you use an email client like Outlook (as opposed to sending/receiving mail through a web 

browser) your email takes up space on your hard drive. A scan with SpaceSniffer will show you how much disk space 

Outlook is using to store your email.  
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If your email is hosted with Microsoft 365 or some other Exchange Server, you can easily reduce the amount of data 

Outlook stores on your hard drive. 

1. In Outlook, click File > Account Settings > Account Settings. 

2. Double click on your email account to open the Exchange Account Settings dialog box. There you will see a slider 

that controls how much email is stored on your computer. The smallest amount is 3 days, and the largest amount is 

All, with various months and years options in between. Move the slider further to the left to store fewer days on 

your computer. Don’t worry, this won’t delete any email. Remember, your actual mailbox is stored on the M365 

servers and Outlook only serves as a tool that lets you interact with that mailbox.  Reducing the amount of mail 

Outlook stores has no effect on your M365 mailbox, it only reduces the amount of disk space being used on your 

computer.  

 

By the way, Outlook doesn’t need to store mail on your hard drive at all, it only does so to make working with email 

faster. By keeping a copy of your mail on the hard drive, Outlook doesn’t have to work so hard to manage your mail. 

Outlook’s feature that stores mail on your hard drive is called Cached Exchange Mode. This is enabled by default, but 

if you want to swap Outlook’s speed and efficiency for disk space, you could turn this feature off altogether.  

How? 



In the Exchange Account Settings dialog box outlined above, uncheck the box for Use Cached Exchange Mode to 

download email to an Outlook data file. Note, if you uncheck the box, the time slider feature turns off since 

Outlook will no longer be storing any email on your hard drive. 

 

 
 

Sadly, this feature is not available for email accounts using POP3 or IMAP (like Gmail). 

 

Missing mapped drive 
A mapped drive is a shortcut to a share on the server or some other device. It appears in File Explorer with your other 

disk drives in the Network locations section and is represented by a drive letter. In the examples below, the drive letters 

are F, G and J. 

 

 
 

Mapped drives are normally mapped (come into existence) when a user logs into his computer. The group policy that 

manages mapped drives attempts to assign a specific drive letter to each mapping at login. Occasionally, one of the 

drives that is supposed to be there goes missing. 

How to fix 
In most environments, (where there is a server) drive mappings occur when a user logs in and the computer receives the 

group policy that manages the drive mappings. There are other ways to map drives, but let’s go with group policy since 

that is the most common way to do it). If a mapped drive is missing, try logging off and then logging back in to retrigger 



the group policy (it’s not necessary to restart your computer. A simple logoff/logon is all that’s needed). If that doesn’t 

work, you can use the Command Prompt to force a group policy update. 

 

1. Click Start and type cmd to search for the Command Prompt. 

2. Command Prompt should show up at the top of the search results. Right click on it and choose Run as adminstrator. 

Click Yes when prompted by the User Account Control dialog box. 

3. In the black Command Prompt window, type gpupdate /force (notice the space) and press Enter. This will force the 

group policy that assigns drive mappings to run and, if there is no other device using the missing drive letter, should 

put things back to normal. 

 

If that doesn’t fix it, look for some other device that is already using the drive letter of the missing drive. A thumb drive is 

a common culprit. Windows assigns drive letters to devices on a first come, first served basis and a newly inserted 

thumb drive may have been assigned that letter. Then, when you logged in, group policy tried to assign the same letter 

to your mapped drive but found it already in use. The result is neither device shows up in File Explorer. 

 

Although File Explorer doesn’t show the rouge drive, the disk management snap-in will. Right click on the Start button 

and choose Disk Management. Here you will see all disks in use as well as the drive letter assigned to them. Look for the 

device using the letter for the missing mapped drive. If it is a thumb drive, just pull it out of the computer and then log 

out. When you log back in again this should reestablish your mapped drives and the missing drive should now take its 

rightful place in the lineup. 

 

Windows 11 

Can I upgrade to Windows 11 
As you may know, Windows 10 does updates on a regular basis. Many of these updates contain bug fixes and security 

patches. Some updates are feature updates that add additional or improved features to Windows. Since Windows 11 

was released in December 2021 your Windows update window may now offer the ability to update to Windows 11 or it 

may tell you that your computer doesn’t currently meet the minimum requirements to run Windows 11. 

To find out if your computer can be updated to Windows 11, Click Start > Settings > Update & Security.  

If your system meets the requirements for Windows 11 there will be a message that offers to update your system. If 

your system does not meet the requirements, you should see this message. 

 

 
 

If you see this, there is no need to panic. It just means your computer’s hardware is old enough that Windows 11 won’t 

run on it. So, what should you do? Well, there’s no need to take immediate action, but you will need to replace your 

computer at some point in the next two and a half years if you want to continue to use a supported version of Windows. 

Windows 10 will continue to be supported until Oct 2025 after which there will be no more security updates and your 

computer will become more and more vulnerable to cyber-attacks. 



 

Should I update to Windows 11 
If Windows Updates offers to update your computer to Windows 11, it means the hardware on your system is 

compatible and upgrading should be no problem, however you should give some thought to this before pulling the 

trigger. The big question is will all the software on my computer work with Windows 11. In most cases the answer is yes. 

All the mainstream software developers like Microsoft and Adobe have all made sure their current products will work, 

however if you have an old version of an app installed, there is some question there. Specialized apps like those that 

target a specific industry (Doctors, Financial institutions, Scientists) should be vetted before doing an update. In most 

work situations, the company’s IT department should make this decision for everyone. For home users, you may need to 

do a little more work yourself. You can always go to the software developer’s website and see if there is information 

about Windows 11 compatibility there. 

 

If you’re a home user and are relatively sure there won’t be any software compatibility issues, you’re probably safe to 

upgrade. If you do upgrade and find there is a problem, Microsoft makes it easy to revert back to Windows 10, if you do 

so within 10 days. After that, you can not downgrade without doing a clean install (big hassle!). 

 

Missing Outlook folder 
It was here yesterday! We’ve heard this many times. Someone has lost an email folder in Outlook. Typically, the folder 

was accidentally deleted or moved inside another folder. It’s easy to move folders by drag and drop and if you aren’t 

careful and drop folder1 on top of folder2, folder1 becomes a subfolder inside folder2. That can be difficult to locate. 

How to fix 
Check the Deleted Items folder first. That’s where all deleted items go, but if it’s not in there, it is probably nested inside 

another folder. In this case Outlook’s Search feature is your friend. The trick is to remember something unique about 

one of the messages in the missing folder and then use Search to find that message. The more unique, the fewer search 

results you will have to wade through. For example, if you know the missing folder contains a message about 

horticulture, you can search for horticulture until you find what you’re looking for. You will need to direct Search to look 

through All Outlook Items since the missing folder is probably inside some other folder. 

 

 
 

 That part is straightforward, however once you find the message, how do you figure out where it is among your many 

Outlook folders? 

1. Double-click on the message to open it in its own window. 

2. Open the Advanced Find feature via the keyboard shortcut CTRL+SHIFT+F. 

3. The In field will tell you the name of the folder that contains the message.  

4. To find where that folder is, click the Browse button. 

 



 
 

5. The Browse button will open a dialog box that reveals the exact location of the folder within the Outlook folder 

hierarchy.  

 

 
 

I can’t open a shared calendar in Outlook 
Scenario: another user in your domain has sent you an invitation to share their calendar. You received the email 

invitation and clicked the link, but nothing happened, and you don’t see the shared calendar anywhere. 

How to fix solution 1:  
Part A: If the shared calendar is the sharer’s default Outlook calendar, ask the sharer to open their calendar app in 

Outlook, right click on the shared calendar in the left panel, and choose Sharing Permissions. Ask the sharer to confirm 

that your account is listed in the Permissions tab and that when they click on your account, the proper permissions 

appear below. The sharer can make any necessary changes and, if needed, even add your account and assign 

permissions right in this dialog box without using an email invitation. 

 



 
 

Part B: After confirming with the sharer that the permissions are correct, in your Outlook’s calendar app, navigate to the 

Manage Calendars group in the ribbon. Click Add Calendar > Open Shared Calendar > Open Shared Calendar. 

Click the Name button and change the address book to Global Address List. 

Select the sharer’s name from the list and click OK. 

The calendar should open in Outlook. 

 

 



 

How to fix solution 2 
It’s possible that when the sharer added your account to the calendar’s permissions, he/she chose your name from the 

Offline Global Address List (OGAL). The accounts listed in the OGAL do not support permissions and cannot be used for 

sharing. The sharer should delete your account from the permissions tab of the Calendar Properties dialog box (shown in 

Solution 1 above) and readd it, being sure to select your account from the Global Address List (GAL) this time. 

 

Outlook is displaying the error: Outlook requires updates before it can start 
 

 

 
 

How to fix 
1. Click Start > Settings > Update & Security 
2. In the right panel, click Advanced Options (bottom of the list). 
3. Turn on Receive updates for other Microsoft products… 
 

 

 
 

4. Click the back button to return to Update & Security 
 

 
 

5. At the top of the right panel, under Windows Update, click Check for updates. 
 



After a few minutes, you should see a long list of Office updates that are pending. They will start to download and install. 

Your computer may restart several times during the installation. Installation may take anywhere from 15 minutes to an 

hour, however Installing these should solve the problem. You can continue to use your computer while the updates are 

installing. 

 

 
 

When using ShareFile to encrypt email messages, Outlook sends from the wrong account 
Scenario: You use ShareFile to encrypt sensitive emails when sending from Outlook and you have more than one email 

account configured. Outlook sends the encrypted message using the wrong email account, even though you specified 

another account. 

 

How to fix 
If you have multiple email addresses configured in Outlook, the ShareFile Outlook Plugin will only send emails with 

ShareFile attachments via the email address listed as the default under Data Files within the Outlook client Account 

Settings. Change the default data file to the one you wish to use for ShareFile. 

 

How: In Outlook, click File > Account Settings > Account Settings. Select the Data File tab. The default email address will 

have a check next to it. Click on the account you want to use as the new default and then click Set as Default from the 

menu. 

 



 
 

Use Microsoft 365 to transcribe your meetings (and other spoken works) 
If you’ve ever had to take dictation or transcribe an audio recording to text, you know how time-intensive it can be, and 

you’ll be happy to know that, for users of Microsoft Word, those days are gone. At least, if you’re using Word as part of 

an Office 365 subscription. This feature allows you to dictate a file in real-time and convert it to a document. You can 

also take an existing audio file and transcribe it into a Word document. This feature comes in handy when you need to 

transcribe a meeting or a presentation from your boss or other colleagues. 

 

First some limitations. If you are using the online version of Word, you can both dictate (speak into your computer’s 

microphone and see your words typed as text in real time) or you an transcribe (convert an audio file to text – either 

prerecorded audio or audio recorded on the fly). If you are using the desktop version of Word, you can only dictate. 

There is no transcribe option. This is because to transcribe, the audio file must first be uploaded to Word and there is no 

facility for doing this in the desktop version. 

 

How to Transcribe Audio in Microsoft Word 
To transcribe an audio file, you need to have Word online. If you try the free version, it will prompt you to sign up for a 

premium account. 

To get started, use the following steps: 

1. Sign in at office.com 

2. In the left panel, click the Word app 

3. Open an existing Word document or create a new one 

4. Begin the transcription by opening the Home tab and clicking the dropdown arrow next to the Dictate button. 

Choose Transcribe. 

If you see a Feature Error appear in the right side panel, you will need to save your document to your hard drive 

before you can continue. Click File > Save as > Download a copy. By default, the copy will download to your 

Downloads folder. Once you have downloaded a copy, you can click the Dictate button again and proceed with 

step 4. This can cause some confusion, because after saving a copy, there appears to be no connection between 

the version of the document you are working on online and the one you just downloaded. Changes made to the 

document under edit are saved in your OneDrive Documents folder and Word seems to forget about the version 

that was downloaded to your downloads folder. 

 



 
 

5. A side panel will open with the Transcribe options. You can either upload an audio file or start recording by speaking 

into your computer’s microphone. 

 

 
 

6. Click the Start recording button. If this is your first time recording a message, you’ll be required to give your PC’s 

microphone access to Word. 

 



 
 

7. Begin recording your message and when you’re done, click the Pause button — and click Save and transcribe now. 

Word will upload your audio to Microsoft and present the transcript in the right panel where you can edit it if you 

wish. If you are happy with the transcription, click Add to document or start over by clicking New transcription. If 

you choose Add to Document, you will be asked what to include: Just text, With speakers, With timestamps or With 

speakers and timestamps. 

 

 
 



 
 

The amount of time it takes to complete the transcribe process will vary depending on the amount of data you have. But 

after it’s complete, it will load to OneDrive for later use. 

 

Managing Transcriptions in Microsoft Word 
If there is more than one speaker in a Microsoft Word transcription, they’ll be identified as “Speaker 1,” “Speaker 2,” 

Speaker 3,” etc... This is handy because you can edit transcriptions. For example, hover over the section that 

needs an edit and click the pencil icon to edit it. 

 

 



 
 

Type in your edit and click the Confirm button. 

 

 
 

When you’re ready to place the transcription in your document, click the Add to document button at the bottom. 

 

What’s the difference between Dictate and Transcribe 
Transcribe, as we’ve seen, records your audio as you speak – or uses a prerecorded audio file - and then sends it to 

Microsoft to be transcribed, returning it then to a side panel in Word where it can be edited before inserting into the 

document.  

 

Dictate inserts your spoken words into the document as you speak them. To help facilitate this, Dictate presents a small 

dialog box that contains a settings cog, a microphone, a Help button and an X to close the recording. Click the 



microphone to begin recording and then click it again to pause recording. As you record, you’ll see your words appear on 

the page. 

 

 
 

Many people we know have used Dragon’s Naturally Speaking to handle transcription tasks in the past, and you may be 

wondering which is better, Word or Dragon. Here’s an article where the writer, a Dragon user tested and compared the 

two. The results my surprise you. 

 

Laptop vs desktop: Which is best for you? 
The debate over which is better, laptop or desktop, has raged for decades now. In the early days of computing, just a 

mere 25 years ago, laptops were the size of suitcases, so the decision wasn’t that hard to make. You really had to want 

to lug one of those around. In those days, adding horsepower to a laptop took space, so besides being heavy and 

awkward to transport, laptops didn’t have the same computing power as a desktop. But as the years passed and laptops 

got smaller and more powerful, the clear line between the two footprints became murkier, until now when laptops and 

desktops are fairly equal in power and laptops are a delightfully small and easy to take on the road. 

 

Laptops are not just for the road anymore 
Today, laptops can do just about anything a desktop can do, and more. For that reason, they are not just being used by 

road warriors, but regular folk are using them to replace their old, heavy, non-transportable desktops. For college 

students, this is a no-brainer. Being able to take a laptop to class allows them total flexibility to take notes, do research 

and even watch videos right in the classroom. In fact, many classes now require students to have a laptop. For the rest 

of us, office and home workers, the decision to go laptop might not be so clear. 

 

Differences between laptops and desktops 
A desktop PC is a static, stationary computer that will stay on a desk in an office or bedroom. It usually consists of 

various parts: a tower, a monitor, a keyboard, and a mouse. PCs are generally more customizable than laptops, allowing 

you to open the case and add memory or add a PCI card that expands the capabilities of the system. In fact, you can put 

together top-of-the-line parts for every aspect of the PC when you choose a desktop computer, whereas your choices 

are more limited with a laptop. 

 

A laptop (also called a notebook) is a portable, all-in-one device that usually has USB inputs on the sides for optional 

peripherals. Laptops have a built-in screen, a built-in keyboard, a trackpad that acts as a mouse, and can vary in size.  

 

Laptops can be powered by plugging into a wall receptacle or can be powered by an included battery. With the laptop 

plugged in, it will run indefinitely, whereas the usable time between battery charges will vary depending on the size of 

the battery, however  many modern batteries are big enough to provide 12 or more hours of power before needing to 

recharge; the Dell Latitude 9510, comes in at a ridiculous 18 hours and 17 minutes! 

 

Laptops are a no-brainer for remote workers 
Since Covid, many businesses have had to rethink their model of having workers come to the office everyday and now 

employ a hybrid approach, whereby users only come to the office when necessary and spend their other workdays 

https://redmondmag.com/articles/2020/11/18/microsoft-word-new-transcription-capabilities.aspx
https://www.laptopmag.com/articles/all-day-strong-longest-lasting-notebooks


working from home. In cases where the user is no longer stationary, it just makes sense to forsake the desktop in favor 

of a more portable solution. Nestlerode and Loy, investment advisors, have been a TekResults client for many years. 

During the height of the pandemic they asked us to help replace their desktops with laptops and now have fully 

converted their business to laptops-only. Office manager, Brian Anderson, told us “It just seems like a natural 

progression for us since laptops have advanced to be able to do everything a traditional desktop can do, with the added 

advantage of portability - and they require less space”. 

 

The argument for a laptop 
Laptops are best used for light work: reading, word processing, streaming videos, or using social media. If you or your 

child wants to have freedom to roam while using a computer, a fully charged laptop should last an entire day for 

working or learning. Although you can buy a USB camera and microphone for a desktop, these already come included in 

most laptops, so if frequent Teams or Zoom meetings are a part of your life, a laptop will help facilitate this. A docking 

station, usually sold separately, allows you to easily connect your laptop to your devices at work (wireless keyboard and 

mouse, printers, monitors, etc.) and then connect to a different set of devices at home. Laptops are designed to connect 

to Wi-Fi, so you can be on the Internet anywhere Wi-Fi is available. 

 

On the con side, laptops are not as durable as desktops. Although not frail, a drop from waist-high could easily crack the 

case or the screen and perhaps damage the internal components. You should also consider the security risks of carrying 

your important data with you. Laptops can be easily stolen or (oh, yes) misplaced. If you decide on a laptop, you would 

be well advised to purchase a security lock cable for it. We can get them for around $40 each. 

 

The argument for a desktop PC 
If you want a computer with a lot of versatility, a desktop PC is for you. Desktops can store huge files and run games with 

high quality graphics easily. Desktops can also be changed to fit your needs. You can add more storage, memory, and a 

better graphics card to improve your computing experience. Desktop PCs also do not run on a battery, so you can use 

them for longer without stopping to plug in and recharge. 

 

You cannot easily transport a desktop computer to a school and, of course, setting it up at a student's desk at school 

would be a nightmare.  

 

Desktop PCs are great for a home-schooled or distancing-learning scenario. A desktop computer can be used during the 

school day for learning and word processing, and during off-hours for gaming and entertainment. 

 

There are also all-in-one PCs, which are stylish devices where their components are built behind the screen. This means 

they are easier to move and set up, as you don't need to connect as many wires, and they take up less space on the desk 

as well. However, they are also more expensive, and not as easy to repair or upgrade as normal desktop PCs. We don’t 

recommend all-in-ones because of the repair and upgrade limitations. 

 

Best bang for the buck 
If a new desktop PC and a laptop have the same specifications, the general rule is the laptop will be more expensive. 

Top-of-the-line laptops generally have higher price points than desktop PCs and they also have all the limitations listed 

above. However, you can save a ton of money by buying a refurbished system. TekResults sells a lot of these and the 

price on refurbs is usually a third the cost of a new computer. We sell slightly older Dell laptops and desktops that were 

big sellers for Dell. This makes replacement parts and replacement systems relatively easy and inexpensive to find when 

the need arises. We install solid state drives and upgrade the memory in all our systems, and then we run a rigorous 

bench test to make sure there are no issues with the hardware. The result is a great, inexpensive system with a proven 

track record. Even better, with our systems, the laptops are generally priced very close to the desktops. 

 

https://www.nlinvestmentadvisors.com/


Great deals! 
Most of our clients have discovered how much money they can save by buying a great refurbished desktop, laptop or 

monitor from TekResults. All our computers are rigorously benched tested, include plenty of memory and a solid-state 

drive and are backed by our 30-day warranty. We have the perfect laptop for returning students and at-home workers, 

with many business-class Dell Latitude laptop models to choose from, starting at around $375. Looking for a monitor? 

We have a variety of bright, beautiful Dell and HP monitors in stock, including some brand-new HPs. Call or email for 

details or to get our recommendations for your specific need. 

 

Who We Are 
TekResults is an independent company and will help you find the best solution at the lowest price. We have many years’ 

experience finding the most cost-effective solutions to IT problems and opportunities. 

 

We are a Microsoft technology partner but also have expertise in non-Microsoft software, Unix and other platforms. We 

can provide services in computer hardware, network, communications, third party software and we can create 

customized software for you. 

 

We have a proven ability to work in all aspects of the systems development and implementation lifecycle and we are 

experts at organizing, planning, and creating cost effective solutions. Whether you want system upgrades, installation or 

complex programming projects, customer satisfaction with every project is the absolute commitment of TekResults. We 

believe this is essential for the long-term success of our client partnerships. 

 

We are members of Centre County Bureau of Business and Industry, The Centre County Information Technology 

Consortium and the Association of Information Technology Professionals. 

 

With offices located in State College and Altoona we are strategically placed to service clients throughout central PA. 

 

We are Your Complete IT Partner. 

Our Services and Products 
− IT problem solving 

− Office 365 sales and support 

− Business phone systems (Comcast, VoIPLy, 
Vonage, Fortinet) 

− Infrastructure design and implementation 

− Pre-Sales consulting 

− Capacity planning/ system design 

− Network cabling 

− Security compliance review HIPAA 

− Security compliance review PCI 

− System installations 

− System upgrades 

− System auditing / documentation 

− Desktop, laptop and monitor and other sales  

− Network administration  

− Network troubleshooting 

− Business consulting software testing and 
service 

− 3rd party software setup and support 

− Computer security solutions (including PGP, 
encrypted mail, secured transactions) 

− Custom application development 

− Legacy system migration and rewrites 

− System integration 

− Application integration 

− Network installation and integration 

− Training and staff development 

 

 

 


